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NOTE:  VoxPro/AudionLabs was acquired by Wheatstone Corporation in 
the fall of 2015. As a result the contact information and support links listed 
in this legacy document are no longer current. Should you require further 
assistance regarding the information presented here, please refer to 
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KKeyeyboboaardrd ShortShortccutsuts  
 
 
 
 

Keystroke Equivalent Keystroke Equivalent 
R Record (start/stop) X, Ctrl+X Cut Selection 
I Insert Record (start/stop) C, Ctrl+C Copy Selection 
P Play from Beginning V, Ctrl+V Paste Selection 
S Play Selection A, Ctrl+A Select All 

Space Bar Play from Cue (start/stop), 
Stop Recording 

K Clear Selection 

Esc Cancel (recordings and 
dialogs) 

  

    

Home Go to Beginning E, Ctrl+E Export 
End Go to End Ctrl+I Import 

Page Up/Down Page Back/Forward   
Arrow Up/Down Scroll List Up/Down Z, Ctrl+Z Undo 

Tab Go to Master / Go to Edit Y, Ctrl+Y Redo 
    

[ Mark Left B, Ctrl+B Bleep Selection 
] Mark Right Ctrl+R Rename File 

Del Delete Selected Audio Ctrl+N New Edit 
    

Î Í Fast Forward/Rewind Ctrl+D Delete Active Edit 
Ctrl+ Î Í Forward/Reverse Slow T, Ctrl+T Empty Trash 
Shift+ Î Í Forward/Reverse Normal   

 
 
 

VoxPro PC can be used with your computer’s keyboard and numpad. 
The complete list of commands to operate VoxPro with the keyboard 
and numpad is under the Help menu. VoxPro PC has an optional control 
panel (see page five). This guide emphasizes its use.
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1 HotKey title.  This is the name of 

an edit that has been assigned to 
the HotKey button directly below 
it.  To assign a HotKey see p 32 
of the User Guide. 

2 HotKey.  There are five of them 
When pressed they instantly play 
pre-assigned Edits. 

3 Delete highlighted audio pp 
17 of the User Guide. 

4 Scroll through HotKey titles five 
at a time. Total maximum is 130 
or 26 rows of five titles p 31. 

5 Control key.  When pressed (with 
audio highlighted) the five hot key 
titles in the LCD are replaced with 
Mute Left, Mute Right, Bleep, 
VOICESLIP left channel before 
right, or right before left p 25. 

6 Deselect key, un-highlights high 
lighted segments of a recording 
sound file or edit. 

7 Option Key.  Pressing the Opt. 
key and a HotKey will assign an 
active Edit to that HotKey. 
Opt-Shift-HotKey erases HotKey. 
Opt-Undo is Redo.  Opt-Play will 

8 Shift key.  Opt-Shift-HotKey 
deletes HotKey. 

9 Up/Down scroll through Edits or 
Masters. 

10 Control panel front plate. 
11 Go to left end of file. 
12 switches from Edit to its Master. 

To get back to the Edit you must 
click on its title. 

13 Undo (all the way back to original 
edit). 

14 Mark Left key marks the left end 
of a pending edit at the cue 
line (edit point). 

15 Cancel key.  Deactivates 
current dialog box. 

16 Stop key stops play and record. 
17 Record key starts recording. 
18 Okay key.  Activates default 

buttons in VoxPro dialog boxes. 
19 Play key.  Starts play from the 

current location of the cue 
line. 

20 Starts playing the file from the 
beginning. 

21 Mark Right key marks the right 
end of a pending edit at the 
cue line. 

22 Play Sel key plays just a high 
lighted area of a file. 

23 Jog Wheel.  Scrub audio to find 
an edit point in a file. 

24 Go to right end of a file. 
25 Insert Record key begins record- 

ing at the cue line inside 
an existing file. 

26 LCD screen is used to display 
HotKey titles five at a time p 32. 
Also displays the Effect menu 
items (see #5) which can then be 
activated with key directly below 
the title. 

27 Paste key allows pasting copied 
or cut audio from one file into any 
Edit file. 

28 Copy key.  Copies highlighted 
audio in a file to paste into the 
same or another file at the verti- 
cal cue line. 

29 Transport keys.  Fast  forward- 
fast reverse, normal speed 
forward-reverse, 1/2 speed 
forward-reverse. 

30 Cut key cuts highlighted audio 
from a file, usually with the inten- 
tion of pasting it back into that or 
another file.
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VoxPro Basics 
 
 
 
 

Logging Into Your Account for the First Time 
 

When you first launch VoxPro PC you must log in as a user using the 
Log In box as shown below. 

 
 

Warning:  Do not allow all users to log into one account, ie. 
Administrator.  VoxPro PC’s data base is designed to handle multiple 
user accounts and file retrieval could slow down if all users use the 
same account! 

 

 
 
If the station Administrator has created an account for you, your name 
will appear in the drop down list. To see the list click on the down arrow 
to the right of the user box, select your name and press the OK button. 
If you have never changed your password since your very first log on, 
you may continue to log in without entering a password. 

 
 

Once the password is changed (see next paragraph) the password must 
be entered each time you log on unless you restore your original 
"password-less" condition. You can do this by simply changing your 
password to your login name. When you next log in, you won't be 
required to enter a password.



8 
 

Changing Your Password 
 

To change your password in VoxPro PC, log into your account, Select 
the Settings menu and select “Change Password”.   Enter your new 
password in the two boxes. After you change your password, you must 
enter the password each time you log on. 

 

 
 
Note:  If you forgot your password, contact your Administrator. The 
Administrator’s password will work in place of your password and allow 
you to enter a new password. 

 

Before Making a Recording 
 

When recording audio, VoxPro PC makes two files. These are: 
1. The Master file - which appears in the Master list (right box). 
2. The Edit file - which appears in the Edit list (left box). 

 

 
 
The Master is non-destructible. It cannot be edited however all or part of 
it can be copied and pasted into Edits.  An Edit can be edited and 
appears as a waveform in the Edit Window above the Edit and Master 
list boxes.
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Making a Recording 
 

Press the Record key on the control panel.  While VoxPro PC is in 
record mode the Mode box at the top center will read “Recording”. 

 
 

 
 
 

To stop recording: Press the Record key or the Stop key (either works). 
A naming dialog box automatically pops up.  Accept the default name by 
pressing “OK” or name the file. If you don’t want to save the recording 
press “Cancel”. 

 

Editing a Recording 
 

To make an edit: Find the area of the waveform to be edited.  Select a 
portion of the waveform in the Edit Window.  You can do this by 
dragging the mouse cursor to highlight a selected area of the wave 
form. 

 
 

 
 

 

Or you can select a portion of the waveform to edit, by marking the left 
end of the audio you intend to edit using the “Mark Left” button on the 
control panel.  Find the right end of the area to be edited and mark the 
right end of the edit using the “Mark Right” button.  The area to edit is 
now highlighted and you can cut, paste, copy or delete it. 

 
 

On keyboard use the “[ “key to mark the left end and “ ]” key to mark 
right end of an edit.
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To Cut (Ctrl+ X): 
 

Select the portion of audio to cut. 
Press the “Cut” button. (Ctrl+ X on a computer keyboard) 
The audio segment is now stored in “Clipboard”. It is available for 
pasting into any Edit at the Cue line. 

 

To Paste (Ctrl+ V): 
 

Position the wave form under the Cue Line at the location in the audio 
file you want to paste audio. Press the “Paste” button on the control 
panel (Ctrl+ V on a computer keyboard).  VoxPro seamlessly 
sandwiches the audio into the recording. 

 

To Copy (Ctrl+ C): 
 

Select the portion of audio to copy. 
Press the “Copy” button (Ctrl+ C on a computer keyboard). This copies 
the edit to the clipboard. (It will appear as though nothing has 
happened, but VoxPro will have silently copied the selected portion of 
audio to its internal clipboard. Paste the audio into any edit at the Cue 
line. 

 

Deleting Audio (Del): 
 

Select the portion of audio to delete. 
Press Delete (Del key on keyboard). 
The audio segment is now removed from the edit. 

 

Undo (Ctrl+ Z): 
 

Press the “Undo” button (Ctrl+ Z). Every press of the button will revert 
back to the previous state of the edit. You may “Undo” back to the 
original recording. 

 

Redo (Ctrl+ Y): 
 

“Redo” undoes each “Undo”. To redo from the control panel, hold down 
the “Option” key while pressing the “Undo” button. Continue redoing to 
the preferred version of the file.



11 
 

Selecting Files in Edit and Master Lists 
 

There are three ways to select files. 
1.     Select one at a time. To select files one at a time, click on the file 
or arrow up and down on the keyboard or controller. 

 

 
 

 

2.     Select a range or series of files. To select a range, or series of 
files, click on the first file in your Edit/Master list. Hold down the shift key 
on your keyboard and scroll to select the last file.  All the files in- 
between with be selected. 

 

 
 
3.     Select multiple, individual files. To select multiple individual files, 
select and highlight the first file in an Edit/Master list. Hold down the 
control key. Select files in any order.  All files selected are highlighted as 
long as you hold down the control key as you click on them. 
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Right Click Menu Items 
 
The real power of VoxPro is available in the right click menus and the 
menus across the top of the VoxPro screen: File, Edit, Effect, Settings, 
Format, Folders and Help. Be adventurous and in no time at all you’ll 
be a power user first class, in full command of the simple but awesome 
power of VoxPro PC. 

 

Right Click Menu Items 
 

 
 
 
Right click menu shows commands available when an edit is active and highlighted. 

 
 
 
 
 
 
 
 
 
 
 

Copy To 
 
 

This command copies an Edit or Master to any other user or Team 
Folder you have access to within VoxPro.  “Copy to” makes a copy of 
the current file(s) selected and makes a new Edit/Master for the user or 
team receiving a copy of the file. If you copy a file(s) to a user or team 
the file(s) are placed in their “Transfer” folder. 

 
 

Move To 
 
 

This command moves a file or group of files to another folder within the 
current user’s folder system or team folder.  Undo ability remains intact 
back to the original recording.
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Referenced To 
 

“Referenced to…” is used to cross reference (help figure out) which 
Masters are contributing parts of themselves to the selected Edit. 

 

 
 
The “Rick Dees Bit” Edit has parts of three Masters in it.  They got there 
by cutting or copying audio from another Edit or Master and pasting it 
into the Rick Dees Edit. 

 
Rename File 

 
 
 

To rename an Edit or Master, select it in the Edit list and right click it.  A 
“Rename” dialog box appears. Now, type over the current title. This 
creates the new title. 

 
 

Note: Changing an Edits name does not change the referenced 
Master(s) names. 

 
Delete 
To delete an Edit, select it and right click it. Select “Delete.”  This moves 
the Edit to the Deleted Files Folder. Note: Edits can be retrieved, 
moved, renamed or exported from VoxPro’s Deleted Files Folder. 
The most recent 25 files are kept; the rest are deleted permanently.
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Export Command 
 

VoxPro PC exports one or more files at a time to any folder you can 
browse to.  By default, stereo files are exported in stereo.  To export in 
mono, click on the “Advanced” button and choose from any of several 
methods of producing a single-channel output from a 2-channel source. 
Files may be saved in WAV, AIFF and WMA (Windows Media Audio), 
MP3 and most popular formats. When exporting a single file, you can 
change the name of the file it is exported to 

 
 

When exporting MP3 files, you may select from four popular bit rates 
(i.e. compression ratios) which provide a trade-off between audio quality 
and file size.  The amount of time required to compress a given file to 
the MP3 format is roughly the same no matter the bit rate chosen.   Files 
exported in this manner will be stereo, CBR-encoded files at the 
selected bit rate. 

 
 

Users who need more precise control over the MP3 format may chose 
the "custom" MP3 option. This configuration uses the "lame_args.txt" 
file to control the parameters to the LAME encoder.  As these 
parameters are quite extensive, we make no attempt to explain them 
here.  The "lame_args.txt" file is found in the LAME Encoder folder 
where VoxPro PC is installed. The interested user will also find a 
"Readme" file here, with a more complete description of this process. By 
default, the "custom" setting produces a 128kbps CBR-encoded stereo 
file.
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Advanced Export Options 
 
 

 
 
 

VoxPro PC can export in stereo or mono.  In the diagram above VoxPro 
is set to export files in mono (One-channel file) where the left and right 
channel are mixed into one mono file and turned down (volume) 6dB. 
The default setting is to export as a two-channel file with both left and 
right channel separated (discrete). 

 
 

New Edit from Master 
 

 
 
 
 

“New Edit from Master” creates an Edit from an active Master.  Activate 
the Master file by selecting its title in the Master list by clicking on it with 
the mouse. 

 
 

Select All 
Select All selects all files in the Edit or Master box.  Once all are 
selected right click again to see what actions you can take.



16 
 

File Menu 
 

 
 

New Master (R) 
 

New Master (Record) starts a new recording.  Press the “Record” button 
on your control panel (“R” key on your computer keyboard). 

 

New Master from Edit (Ctrl+ M) 
 

New Master from Edit creates a new Master and Edit file from the entire 
active Edit.  Once the new Master is created you may delete the old 
Edit. This deletes the old Master as well. 

 

New Master from Selection 
 

New Master from Selection makes a new Master and Edit from any 
highlighted portion of an Edit or Master. 

 
 

�� Highlight the section of the audio to make a new Master 
�� Select “New Master from Selection” sub menu. 
� The “Save Master” dialog box appears prompting you to name the 

new file. 
�� Name the file or press “OK” to accept the default file name of 

“Untitled 1” etc. 
� The newly named Edit and Master appear in the Master and Edit 

lists.
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New Edit (Ctrl+ N) 
 

New Edit creates an empty Edit. Note:  New Edits don’t allow “Insert 
Record” activity until audio is pasted from another Edit or Master into the 
new Edit. 

 
New Edit from Master 

 
 

“New Edit from Master” creates a new Edit from an active Master. 
Activate the Master file by selecting its title in the Master list by clicking 
on it with the mouse or use the list scroll keys. 

 

Rename Active File (Ctrl+ R) 
 

Selecting “Rename Active File” brings up the “Rename Active File” 
dialog box.  The current file name appears in the Rename window. 
Renaming an Edit does not rename its corresponding Master or Masters 
and vice versa. 

 

Delete Active File (Ctrl+ D) 
 

Choosing "Delete Active File" moves the file the Deleted Files Folder. 
To delete multiple files or multiple files in a range see page nine of 
VoxPro Basics. 

 

Go to Master (Ctrl+ G) 
 

VoxPro PC’s “Go to Master” function locates each Edits corresponding 
Master.  If there are parts of several Masters in an Edit the position of 
the Cue line will determine which Master this command will take you to. 

 

Import (Ctrl+ I) 
 

Import allows one or more media files to be imported at one time into 
VoxPro PC.  VoxPro imports these file types: standard Windows Wave 
(.wav); MPEG-1 layers 1, 2 and 3 (.mpg, .mp2, .mp3, .mpa); Windows 
Media (.wma, .wmv); Advanced Streaming Format (.asf); and Audio 
Interchange File Format (.aif, .aifc, .aiff).  VoxPro PC will also extract the 
audio data from a Windows Media file that contains both audio and 
video streams.  However, MPEG-1 files must contain audio only in order 
to be imported by VoxPro PC. 
VoxPro PC performs an automatic format conversion when importing 
files whose format does not match that currently set in VoxPro.
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Note: There are three ways to select files to import or export: 
 
 

1. Select files one at a time. To select files one at a time, click on the 
file with the mouse or arrow up and down on the keyboard or controller 
until a file is highlighted. 

 
 

2. Select a range or series of files. To select a range, or series of 
files, click on the first file in your Edit or Master list. Hold down the “Shift” 
key on your keyboard and scroll to select the last file.  All the files in- 
between with be selected. 

 
 

3. Select multiple, individual files. 
To select multiple individual files, select and highlight the first file in an 
Edit or Master list. Hold down the “Control” key. Select the rest of your 
files in any order. All files selected are highlighted as long as you hold 
down the control key as you click on them. 

 
 

To Import Files 
 
 

�  Select “Import.” A browser window appears. 
 
 

� Browse to and select the file or files for importing.  VoxPro imports 
most popular formats including MP3 files.  After selecting, Click 
“Open.” 

 
 

�  VoxPro will then proceed with importing those files. 
 

Export (Ctrl+ E) 
 

“Export” allows single or multiple VoxPro PC Edits and Masters to be 
exported in WAV, WMA (Windows Media), AIFF and MP3 formats. 
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Once you have selected a file(s), 
 

Right click on the selected file(s) and choose “Export.” The Export File 
dialog box appears as shown above. 

1. Click on the “Browse” button. Navigate to the new file location on 
your network. 

2. Select the file format (WAV, WMA, AIF or MP3) from the pull 
down menu. 

3. Pressing the Advanced button brings up a boatload of exporting 
options. VoxPro comes with the first optional Export Format 
checked (default) and this will be the format used most often. 
(In the graphic below the second export Format is selected to 
show the Export Options not grayed out.) 

 
 

Export Format 
 
 
There are three export formats as shown.  In most cases the first format, 
“Two-channel file with discrete left and right channels”, the default 
format, will be used most often.  Unless you have a particular reason to 
use a different format it is suggested you stay with this format. 
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Export Formats 
 
 

1. Two-channel file with discrete left and right channels 
 
 

This is a normal stereo file format usually with a caller in one channel 
and air talent in the other. (See explanation above under Export 
Format.) 

 
 

2. Two-channel file with identical left and right channels 
 
 

VoxPro creates a two channel file where both channels are identical. 
For example, if you choose “Use left channel only” from the export 
options below, then both left and right channels of your exported file will 
be made from the left channel of your recording. 

 
 

3. One-channel file 
 
 

VoxPro creates a one channel file with the same export options as the 
“Two-channel file with identical left and right channels” above. 

 
 

Empty Deleted File Folder (Ctrl-T) Export Formats 
 
 

All deleted files go to the Deleted File Folder (formerly the Recycle Bin). 
The Deleted File Folder will only hold the last 25 named and deleted 
Edits/Masters. 

 

Logout (Ctrl-L) 
 

Logs out the current user. 
 

Exit 
 

Quits the VoxPro application.
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Edit Menu 
 
 
 
 

 
 

The “Edit” menu contains options that manipulate selected (highlighted) 
portions of audio. VoxPro PC’s Cut, Copy, Paste, and Delete commands 
are central to all VoxPro editing tasks. 

 

Undo (Ctrl+ Z) 
 

Undo reverses editing actions. Undoing repeatedly takes you back to 
the original, unedited Edit. Even if the Undos are days old, you can 
reverse all edits as long as the file remains in the original creator’s folder 
system. 

 

Redo (Ctrl+ Y) 
 

Redo reverses all undo actions. To redo an action on the control panel, 
hold down the Option key and press the “Undo” button. 

 
 

Cut (Ctrl+ X) 
 
 

Cut removes highlighted sound segments from an active Edit.  The Cut 
command does not work on Master Recordings.  To cut audio from an 
Edit use the Mark Left and Mark Right buttons on the control panel or 
the left or right brackets on the keyboard ( [  ] ) or use the mouse and 
drag to select and highlight audio. Removed audio is stored in VoxPro 
PC’s clipboard and is ready to be pasted into the current Edit file or any 
other Edit file at the Cue line.
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Copy (Ctrl+ C) 
 

“Copy” copies highlighted sound segments from active Edits or Masters. 
There are two ways to select and highlight in the edit window.  You can 
click and drag the mouse cursor over the audio you want to copy, or you 
can use the “Mark Left” and “Mark Right” buttons on the control panel, 
or the left or right brackets on the keyboard ( [  ] ), to select an audio 
segment.   Audio is copied (not removed), and is ready to be pasted into 
the active edit or any other edit. 

 

Paste (Ctrl+ V) 
 

To paste cut or copied audio, position the Cue line to the desired point 
in an Edit.  Press the “Paste” button on the control panel or the Control 
key and “V” key on the keyboard. The audio stored in VoxPro PC’s 
clipboard is then inserted into the chosen Edit at the Cue line. 

 

Delete 
 

Delete erases highlighted sound segments within an Edit Deleted 
segments are not saved on VoxPro’s clipboard. The Delete command 
does not work on Master Recordings. 

 
 

To delete audio in an edit, use the “Mark Left” and “Mark Right” buttons 
on the control panel or the left or right brackets on the keyboard ( [  ] ) to 
highlight the audio you wish to delete.  Press the “Delete” button on the 
control panel or keyboard. This removes the selected audio. 

 
 

Pressing the “Undo” button on the control panel or the control and “Z” 
key on the keyboard replaces deleted audio.  Do this multiple times to 
affect multiple Undos. 

 

Select All (Ctrl+ A) 
 

Select All selects all audio in the active Master or Edit. 
 
 

Insert Record (i) 
 
 

“Insert Record” inserts newly recorded audio into an active Edit, 
automatically sandwiching it into the recording. Newly recorded audio is 
inserted at the cue line. Insert Record does not work on Masters. 

(Continued)
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To “Insert Record”, position the waveform in the Edit Window under the 
Cue line at the point you wish to record.  Press the “Insert Record” 
button on the control panel, or the “i” key on the keyboard. VoxPro PC 
keeps the inserted segment highlighted after recording.  If dissatisfied 
with the insert recorded audio press the “Delete” button to try again. 

 

Effect Menu 
 

 

If the Effect submenu commands are grayed out it is because a portion 
of audio must be highlighted for these commands to work. 

 
 

Shortcut Note: If you have a control panel, pressing the Control button 
(small, upper left corner) will bring up the effect menu in the control 
panel’s LCD.  While holding down the control button press the key under 
the effect title in the LCD screen you want to apply. 

 

Adjust Volume 
 

This effect allows volume (gain) to be adjusted in 1dB increments up or 
down to a maximum of +/- 24dB. The volume change may be applied to 
either or both channels. 

 

Bleep 
 

Highlight a word in the waveform in the Edit Window. Select “Bleep.” 
 

Insert Silence 
 

Insert Silence allows you to insert silence into an Edit without muting any 
existing audio.  To insert silence, position the waveform under the Cue 
line at the point where the silence is to begin.  A dialog box prompts you 
to insert silence of any duration. You can insert no less than 0.01 
seconds and no more than 99 seconds.
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Mute 
 

Mute replaces the highlighted, selected portion of an active Edit with 
silence. 

 
 

To mute, highlight an area of the waveform to mute.  Select “Mute.” 
A dialog box then prompts you to make one of the following selections: 

1. Mute left and right channels. 
2. Mute left channel only. 
3. Mute right channel only. 

 
 

Muted selections appear as gaps in the waveform. 
 

VOICESLIP™ 
 

VOICESLIP is available in stereo mode only. VOICESLIP automatically 
eliminates host/caller “Talk Over.” 

 
 

�� To use VOICESLIP, highlight the portion of audio where “Talk 
Over” occurs. 

�� Select VOICESLIP from the “Effect” menu. 
�� Select “Right Before Left” or “Left Before Right.”  (“Left” and “Right” 

refer to the left and right channel.) 
 
 

VoxPro PC automatically slips the channels as chosen.  After using 
VOICESLIP, unwanted audio can be highlighted and deleted. 

 
 

Tip:  See shortcut note on previous page.
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Settings Menu 
 

 
 

Play Direction 
 

Play direction opens a submenu that allows users to select the direction 
of the “tape” runs. The options are “Right-to-Left” and “Left-to-Right.” 
Default direction is Left-to-Right. 

 

Play Options 
 

Play Options refers to the choice of playback formats. 
 

Discrete Left and Right 
 

In most cases the default, Discrete Left and Right, will be the preferred 
playback format.  This allows a caller, say, in one channel and air talent 
in another. 

 

Mono Mix 
 

Plays back a mix of both left and right channels on both output channels 
(i.e. both channels will carry the same signal).  Note that this can cause 
clipping on the output if both source channels are very hot. 

 

Mono Mix -6dB 
 

Plays back both left and right channels mixed together in a mono file in 
both the left and right channels as above, but minus 6dB of volume. 
Used for stereo recordings where you want the mono sum to be the 
same apparent volume level as the original stereo recording.
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Mono Mix -12 dB 
 

Plays back both left and right channels mixed together in a mono file in 
both the left and right channels as above, but minus 6dB of volume 

 

Left Channel Only 
 

Plays back only the left channel in both the left and the right  channels. 
 

Right Channel Only 
 

Plays back only the right channel in both the left and right     channels. 
 

Control Panel 
 

Control Panel opens the dialog box below. 
 
 

Note: that when a Mac control panel is selected, the normal keyboard 
shortcuts, HotKeys and remote starts from console cannot be used. 

 
 

The default is Use The PC Control Panel 
 
 

Note:  Audion Labs no longer offers a Mac version of VoxPro, but Mac 
control panels are usable with the PC software 

 
 

Reset Controller 
 
 

“Reset Controller” re-establishes contact with the control panel.  For 
example, if the control panel becomes unplugged from the computer 
then plugged in again, pressing the Reset Controller button will re- 
establish contact between the computer and control panel. 

 
 



27 
 

Scrub 
 
 

When a Fast Forward or Reverse key is pressed and held down VoxPro 
will perform two tasks: Audio scrub followed automatically by fast 
forward or reverse without audio until the key is let up. 

 
 

 
 
 

Adjusting scrub length 
 
 

To adjust audio scrub length (amount of time you hear fast audio before 
fast forward or reverse kicks in) the “Enable audio scrub” box must be 
checked as shown in the above figure.  (VoxPro PC comes with the 
Enable audio scrub box un-checked) 

 
 

To adjust the length of time audio scrubs when a fast forward or reverse 
key is pressed and held down, move the Length of Audio Scrub slider to 
the left or right and press the OK button. 

 
 

Move the marker to the left or right on the Fast forward/reverse slider to 
increase or decrease the speed of fast forward and reverse and click the 
OK button.  You can always go back and change it any way you wish. 

 
 

Note:  With the Control Panel you can scroll through a file holding a 
Fast Forward or Reverse key down and pressing the Play Forward key 
at any point during the process to hear what is at that point in a file. 
Letting up on the play key while continuing to hold down the Fast 
Forward or Reverse key will continue scrolling at that speed.  Doing this 
multiple times is possible to check various points for content.
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Change Password 
 

After you change your password the first time, you must enter the 
password each time you log on.  “Change Password” brings up the 
“Change Password” dialog box. To change your password, enter your 
old password in the first box and your new password in the second and 
third boxes for verification. Passwords are not case sensitive. 

 
 

 
 
 

Note:  If you have not changed your password since the time you first 
logged on the “Enter your old password” box will be disabled. 

 
If you forget your password, contact your VoxPro PC Administrator. The 
Administrator can temporarily use the administrative password in place 
of your old password. 

 
 

If you want to restore your original "password-less" condition, simply 
change your password to be the same as your login name.  When you 
next log in, you won't be required to enter a password.
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Format Menu 
 
 
 
 
 
 
 
 

 

Choose from VoxPro’s 44100Hz, 16-bit Mono format or 44100Hz, 16-bit 
Stereo format to record and playback files. 

 
 

Mono files cannot be seen and are not accessible in stereo mode and 
stereo files cannot be seen and are not accessible in mono mode. 

 
 

Suggestion:  Because having the caller in one channel and the air 
talent in the other gives the most editing options, including automatic 
separation of host and caller talkover with VOICESLIP, Audion Labs 
recommends you use the stereo mode at all times. 

 
 

Switching between the two formats is not recommended as files in 
one format will not show up when the other Format (Stereo/Mono) 
is selected.
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Folders Menu 
 

 
 
 

Every time a user logs in, the folder they were last in when they logged 
out will be the folder that opens by default.  In other words, if the folder 
they were working in when they logged out was the Transfer folder the 
Transfer folder will be the folder they start in at the next log in. 

 
 

When you make any recording in VoxPro you are recording in a Folder. 
VoxPro provides all users (except Guest) with four basic, indestructible 
folders:  Default, HotKeys, Deleted Files and Transfer.  Users can 
create additional folders as needed with Manage Folders. 

 
 

To tell what folder you are in at any one time check the title bar at the 
top of the VoxPro screen. You will see the user name, and the name of 
the folder you are currently in. Another way to check the folder you are 
in is to go to the Folders menu and see which folder has a check mark 
to the left (see figure above). 

 
 

The list of Edits displays the edits of the current folder.  The Masters list 
always displays your complete list of masters no matter what folder your 
edits are in. 

 
 

Note:  You can sort all your Edits and Masters alphabetically, by length 
or by date modified by clicking on the Edit or Master list header bars at 
the top of each list.
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In the example above the Edits are sorted alphabetically.  As files are 
added they are placed in alphabetical order.  If you click on the Modified 
Header bar, files will be added according to their last modified time etc. 

 
 

Default Folder 
 
 

When you first start out in VoxPro PC this is the folder you will be in. 
Many people will always use this folder and never get to others.  Not 
necessarily a bad thing, but definitely not the way a power user would 
use VoxPro PC.  Folders are very useful to organize files. 

 
 

HotKeys Folder 
 
 

Any Edit can be assigned to a HotKey and played back instantly.  Edits 
which are assigned to HotKeys are copied to the HotKeys folder.  Note 
that the Guest account does not have HotKey capabilities; nor do 
VoxPro workstations without PC-style control panels. 

 
 

Assigning a file to a HotKey 
 
 

To assign a file to a HotKey, press the Option key on the control panel 
and press the button under the LCD screen you want it assigned to. 
The title of the Edit will appear there. 

 
 

To edit the HotKey go to the HotKeys folder under the folder menu.  You 
can also rename the file so it fits in the LCD better.  The LCD supports 
seven letters per line. 

 
 

To remove a HotKey, press and hold down the Option and Shift keys on 
the control panel and press the corresponding key under the HotKey 
title in the LCD. 

(Continued)
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To rename a HotKey, highlight it and choose Rename Active File under 
the File menu. 

 
 

When five HotKey titles fill the LCD screen on the control panel, press 
the scroll up and down keys to the left of the LCD to reveal five more 
available HotKey title spaces. You can have a total of 130 Hot Keys in 
26 banks of five titles. Each Edit file name starts with a bank/position 
label. 

 

 
 
To change the location of a HotKey right click on the file and select 
Reassign HotKey. It will allow you to change the position to any bank A- 
Z and position 1-5 that is available. 

 
 

To delete a HotKey in the HotKey Folder, select the file, right click and 
choose Delete. 

 
 

Deleted Files Folder 
 
 

This is a folder that holds the 25 most recently deleted and canceled 
files.  To delete these 25 files press <Ctrl+T> or go to File Menu and 
choose: Empty Deleted Files Folder. 

 
 

To see what you can do with files in the Deleted Files Folder right click 
on an Edit.  You will see this window: 

 

  (Continued)
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Select all will do just that and right clicking on them again will allow you 
to delete them all at one time etc. 

 
 
 

Transfer Folder 
 
 

The Transfer folder contains all the files that have been copied to you 
from other users.  Once the file is copied to you it will automatically 
appear in your Transfer folder. From here you can copy or move it to 
any of your other folders. 

 
 

Manage Folders 

This is where you add and delete personal folders and Team folders. 

Creating folders is a great way to organize and archive files you can get 
to easily.  Typical Titles are Monday, Tues, etc. or Winners etc. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Add Personal Folders 

 
Select the submenu “Manage Folders/Add Personal Folder” from the 
“Folders” menu.  Name the new folder in the dialog box. Click “OK.”
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Your new folder will be added to your list of existing folders ready for 
you to create files in or move or copy files to. 

 
 

Deleting Personal Folders 
 
 

Folders must be empty before they can be deleted. To delete a personal 
folder go to the “Folders” menu. Select the “Manage Folders” sub 
menu. 

 

 
 
Select “Delete Personal Folder.”  The “Delete a Personal Folder” dialog 
box appears. Select the folder to be deleted in the pull down menu. 
Press “OK.” 

 
 

Adding Team Folders (within a Team account) 
 
 

Teams can only be created by the VoxPro PC Administrator.  If your 
Administrator has given you permission to belong to a team you may 
create and name folders that all team members can access.
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Select “Manage Folders/Add Team Folder” submenu from the “Folders” 
menu.  Type in the Team name. Name the folder and press “OK.”  The 
newly created folder will appear in the Team’s list of folders. 

 
Deleting Team Folders (within a Team account) 

 
 

Folders must be empty before they are deleted.  Go to the “Folders” 
menu. Select the”Manage Folders” sub menu. Choose “Delete Team 
Folder.” 

 
 

A Delete Team Folder dialog box appears.  Select the Team Folder to 
be deleted in the pull down menu and press “OK.”
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Help Menu 
 
 
 
 
 

 
 

Keyboard Shortcuts 
 
 

This command displays a graphic representation of a computer 
keyboard, showing the function(s) assigned to each key.  As you move 
your mouse over each assigned key in the image, a helpful pop-up 
window appears explaining the function of that particular key.  Note that 
this window is disabled if the Classic Mac control panel is enabled. 

 
About VoxPro PC 

 
 

This command displays your current VoxPro PC version, registration 
key, and Audion Laboratories' contact information. 

 
 

User Guide 
 
 

This command displays this User Guide as a .PDF file using Adobe 
Acrobat.  To download Acrobat Reader go to: 

 
 

http://www.adobe.com/products/acrobat/readstep2.html
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VoxPro Tricks 
 
 

Shortcut to Effect Menu 
 
 

To display the Effect menu in the LCD window on VoxPro PC control 
panel, press and hold down the small “Control” button on the panel.  (It 
is located with three other keys in the upper left corner of the panel.) 
You will see the Effect menu items displayed in the LCD.  Pressing the 
black button under each entry on the LCD will activate that function. 

 
 

Drag Wave Form 
 
 

To drag the Wave Form press and hold the Control key down and move 
the mouse left or right 

 
 

Small Jumps Forward and Reverse for Surgical Like Editing 
 
 

To move forward or reverse in increments of 1, 2 or 4 hundredths of a 
second, quickly click on the forward or reverse buttons on the control 
panel. This will result in moves of 4 hundredths of a second.  Doing the 
same while holding down the Shift key on the computer keyboard will 
move the file 2 hundredth and holding down the Ctrl key on the 
keyboard moves the file 1 hundredth of a second. 

 
 

If you have a control panel with six transport buttons quickly clicking on 
the fast forward or reverse key will move the file 4 hundredth of a 
second.  Quickly clicking on the regular speed forward or reverse results 
in jumps of 2 hundredth of a second and quickly clicking on the half 
speed buttons moves the file 1 hundredth of a second. 

 
 

Sort Files by Name, Length, Last Date Modified 
 
 

At the top of the Edit and Master windows, right above the titles of the 
recording files, are three rectangles with the words Name, Length, 
Modified.  Click the Name box and notice that VoxPro sorts the list of 
recordings alphabetically in descending or ascending order.
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Administrator 

Glossary
A person designated to be responsible for the operation of the VoxPro 
PC system, probably the IT person, engineer or PD.  The administrator 
uses a special area in VoxPro to create and organize other user spaces 
and memberships in specialized areas such as Team Folders. 

 
Control Panel 
VoxPro PC software can be executed by the computer keyboard or 
VoxPro PC’s outboard control panel.  The control panel contains a jog 
wheel for fine audio scrub, a six inch LCD screen that lists 26 banks of 
HotKey titles and various other control keys such as fast 
forward/reverse, cut, copy, paste etc. 

 
Cue Line 
The stationary, vertical line in the center of the Sound Window that is 
analogous to a playback head. As the sound wave moves under it 
audio is heard.  Edits are marked at its position on the waveform. 

 
Cut 
Editing action that removes highlighted audio which can then be pasted 
within the same recording or another recording. 

 
Copy 
Editing action that copies, but does not remove, highlighted audio in and 
Edit or Master.  It can be pasted into the existing Edit or any other Edit. 

 
Default Folder 
The Default folder is a space created for each user and Team so that 
when they first start using VoxPro they are able to save audio files.  The 
Default folder allows you to use all the functions of VoxPro PC.  Think of 
the Default folder as a place to record files before you decide where you 
want to file them away. 

 
Deleted Files Folder 
The Deleted Files folder is where files are placed once they are deleted 
from any other folder. They are not permanently deleted here.  Files 
created in the Deleted Files folder will be placed in the Default Folder.
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Disk Left Indicator 
Located in the upper right hand corner of the VoxPro PC screen, it 
indicates the amount of hard drive available for recording on the volume 
that the current folder. VoxPro PC uses 10 MB of disk space a minute 
in the stereo mode. 

 
Headroom 
Headroom refers to the approximate number of dB between the top of 
the Sound Window and the point where input clipping occurs. 
Headroom is like a safety factor that allows for instantaneous peaks 
which are higher than the displayed average peaks used to set level. 

 
HotKeys 
HotKeys are a set of five buttons on the optional VoxPro PC control 
panel.  Anything recorded on VoxPro PC can be assigned to these 
buttons.  Once assigned, the recording can be played back instantly by 
pressing the corresponding HotKey. 

 
HotKeys Folder 
The HotKeys folder is a space that contains all the Edits that you assign 
to be HotKeys.  HotKeys that are available are shown in the LCD 
window on the VoxPro PC control panel.  You can not make new 
recordings in the HotKeys folder, nor can you move or copy files to the 
HotKeys folder. 

 
 

HotKeys are arranged in 26 banks of 5 each.  Files get placed in the 
HotKeys folder only when a user assigns an Edit in another folder to be 
a HotKey.  Once a HotKey is assigned the only way to change that 
HotKey is to edit the audio file in your HotKeys Folder.  Looking closer in 
the HotKeys folder you will find that each Edit file starts with the 
HotKeys position reference. To change the location of a Hotkey, just 
right click with your mouse on the file and select reassign HotKey.  It will 
allow you to change the position to any bank A-Z and position 1-5 that is 
available. 

 
 

To delete a HotKey, select the file, right click and select Delete.
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Keyboard Shortcuts 
Many of the menu commands can be executed by pressing one or more 
keys on the keyboard, instead of using the mouse to pull down the 
menus and choosing the command from there.  A list of keyboard 
commands is available in the User Guide found under the Help Menu. 

 
Menu 
The menu bar is the list of menu titles that appears across the top of the 
screen when VoxPro PC is running. 

 
Paste 
Editing action that takes cut or copied audio segments and inserts them 
into any Edit. 

 
Scrubbing 
Physically moving the tape back and forth over a playback head on a 
tape recorder to locate an exact spot in the sound is called scrubbing. 
With VoxPro PC the same thing can be done by using the play forward 
and play reverse buttons. 

 
Teams and Team Folder 
Teams are created by the administrator and allow Team members to 
work together and share files. When a user is given access to the Team 
space by the administrator, he/she is able to record, edit, and play back 
files from within folders in that space. 

 
 

The Team space is a great place to organize files that can be used by 
all the members of the team throughout the day.  For example, folders 
can be made and titled with names like Contest Winners, Traffic, 
Weather, Funny Bits, Production, or Promos, and be available to all 
members. 

 
 

A VoxPro PC workstation that is networked via the VoxPro PC Network 
plug-in allows team members to share the same screen and instantly 
see files that other team members create.  Files can then be copied, 
moved, played back or edited by any team member.
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Transfer Folder 
The transfer folder contains all the files that have been copied to you 
from other users.  After a file appears in your Transfer folder, it can be 
moved or copied to any other folder in your space. 

 
VOICESLIP ™ 
Automatically inserts silence in the left and right channel after an area of 
audio is highlighted and VOICESLIP is chosen under the Effects menu. 
This allows deletion of audio in either the caller or host channel to get rid 
of talk-over. 

 
Waveform 
The waveform appears inside the Sound Window, the long, horizontal 
rectangle above the Edit and Master boxes on the screen interface. 
Waveforms are a drawing that is a representation of the audio.  In 
VoxPro PC the wave form can be made to move left to right, or right to 
left using the Play Direction submenu under the Settings menu title.



42 
 

Index 
 

Administrator, 38 
Audio Scrub. See Scrub 
Audion 

Phone number, 1 
Street address, 1 
Web address, 1 

Gain Adjust, 23 
Glossary, 38 

 
Headroom, 39 
Help Menu, 36 
Highlight area of Waveform, 9 

Recording 
Start recording, 16 

Redo, 10, 21 
Rename Active File, 17 
Right Click Commands 

Copy to, 12 
 HotKey Folder, 31 Delete, 13 
Bleep, 23 HotKeys, 39 Menu, 12 
 Assign file to HotKey, 31 New Edit From Master, 15 
Change Password, 8, 28 HotKeys Folder, 39 Referenced to, 13 
Control Key, 6  Rename file, 13 
Control Panel, 4, 26, 38 Import, 17 Select all, 15 

Control Panel Guide, 6 Insert Record, 22  
Mac Panel. See Mac Insert Silence, 23 Scrub, 40 

Control Panel  Adjust fast fwd/reverse 
Reset, 26 Keyboard Shortcuts, 36, 40 speed, 27 

Copy, 10, 22, 38  Adjust length, 27 
Cue Line, 38 Log On, 7 Select All, 15, 22 
Cut, 10, 21, 38 Log Out, 20 Select wave form, 9 
  Selecting Files 
Default Folder, 31, 38 Mac Control Panel, 26 In a range, 11 
Delete Active File, 17 Master Multiple individual files, 11 
Delete Audio, 22 Go to Master, 17 One at a time, 11 
Deleted Files Folder, 38 Menu, 40 Settings Menu, 25 
Deselect Key, 6 Mono Mix, 25 Shift Key, 6 
Direction Of Play, 25 Mono Mix -12dB, 26 Sort Edit/Master list, 30, 31, 
Disk Left Indicator, 39 Mono Mix -6dB, 25 37 
  Speed Adjust 
Edit New Edit from Master, 15 Fast fwd/reverse, 27 

Create empty edit, 17 New Master from Edit, 16  
Delete, 17 New Master from selection, Table of Contents, 2 
New edit from Master, 17 16 Team Folder, 40, See 
Rename, 17  Folders: Creating Team 

Edit Menu, 21 Option Key, 6 Folder 
Effect Menu, 23  Transfer Folder, 33, 41 
Exit VoxPro, 20 Password  
Export, 14, 18 Change, 8, 28 Undo, 10, 21 
 Paste, 10, 22, 40  
Fast fwd/Reverse Personal Folder, 33 VOICESLIP tm, 24, 41 

Adjust Speed, 27 Play Direction, 25 Volume Adjust, 23 
File Menue, 16 Play Options, 25 VoxPro 
Folders Discrete Left and Right, 25 Tricks, 37 

Create, 33 Left Channel Only, 26 Version number, 36 
Create team folder, 34 Mono Mix, 25 VoxPro Basics, 7 
Delete personal folder, 34 Mono Mix -12dB, 26 VoxPro Screen Guide, 6 
Deleting team folder, 35 Mono Mix -6dB, 25  

Folders Menu, 30 Right Channel Only, 26 Waveform, 41 
Format Menu, 29   
 Quit VoxPro, 20  



 

 


